A consortium is defined as an association of two or more organizations that have come together to jointly fund research projects through external funds and pooled membership fees. This job aid serves as a guide for the administrative processing of consortium agreements to establish new consortiums, new memberships, renew existing memberships, consortium-funded projects, and to modify terms and conditions of existing membership agreements. Additional information can be found in the Consortiums Topical Guide.

For this job aid, the term “member” and “sponsor” will be used interchangeably and will refer to an external party who is providing funds to the consortium via membership fees or through the sponsoring of research projects conducted by the consortium. Members or sponsors do not perform work. The work under a consortium is performed by consortium partners (e.g. other universities and/or independent faculty members). If a consortium wishes to add a consortium partner, the Consortium RA may do so by sending a request to proposalandnegotiation@asu.edu. It will then be determined whether or not an FP is needed.

Table of Contents

Creation/Initiation of a Consortium ................................................................. 2
New Memberships ........................................................................................... 4
Membership Renewals ..................................................................................... 7
Consortium Projects ....................................................................................... 8
Modifications .................................................................................................... 10
Financial Management .................................................................................... 11
ERA SmartForm Instructions .......................................................................... 14
1) Creation/Initiation of a Consortium

a) Proposal Submission

1. The RA determines the type of consortium.

**Type I** The consortium has a main sponsor that is external from ASU (e.g. a federal sponsor such as an NSF Industry and University Cooperative Research Program [I/UCRC] where NSF provides a standard grant to support the consortium in addition to the membership fees or an industry sponsor such as Honeywell).

**Type II** The consortium will be supported by membership fees and external funds provided to fund consortium research projects. This is an internal initiative (i.e. not submitting to a federal or industry sponsor to supply the primary source of funds for creation). It is created by a faculty member who submits a *business plan*. The business plan is routed for approval via ERA to the Department Chair, Dean, and the Senior Vice President of Knowledge Enterprise Development (OKED) as part of the FP approval process.

2. The RA creates an FP in ERA

**Type I**

1) Following creation of the *New ERA Sponsor Request* and *new agency/org codes*, create an FP using *Create and Route Funding Proposal WI*. The *business plan* should be attached in 19.0 of the ERA SmartForm 8.1, (Internal Reference Attachments).

2) Other types of proposal documents included will depend on the requirements of the primary sponsor.

**Type II**

1) Request creation of a new sponsor code using the *New ERA Sponsor Request*. Use the consortium name (e.g. AIMS) as the sponsor name.

2) Obtain a new agency/org by submitting a *New Agency/Org Application form to Financial Services*.

3) Following creation of the new sponsor and agency/org codes, create an FP using *Create and Route Funding Proposal* WI. The *business plan*, which serves as the entire proposal package, should be attached to 19.0 on SmartForm 8.1, (Internal Reference Attachments).
b) **Notice of Award/Intent to Fund**

**Type I (INITIAL SET UP)**

1) The RA will run the activity to reflect the sponsor’s intent to fund.

2) The RA will upload the official award notice to the FP.

3) The GCO will run the activity to .

4) The Proposal and Negotiation Team (PNT) will be prompted to assign a GCO Agreement Reviewer and to set up a contracts task in SharePoint.

**NOTE:** If the award notice is received directly by AMT, AMT is responsible for routing to the proposalandnegotiation@asu.edu. A GCO Agreement Reviewer will be assigned and a contracts task will be set up in SharePoint.

**Type II (INITIAL SET UP)**

1) The RA notifies the GCO on the original FP for the establishment of the consortium, that a request for a new membership agreement has been received by running the activity.

2) The RA takes a screenshot of the completed approvals of the business plan, combines it with a pdf copy of the business plan and uploads the document to the notification sent to the GCO. This document will be considered the award letter.

3) The GCO runs the activity and uploads the award letter, also selecting the "route to PNT" option. The GCO will then assign him or herself as the GCO Agreement Reviewer, so that an additional SharePoint task is not set up.

4) The original FP will remain in “Award Letter Received” status until the New Membership agreement FP request has process and fully executed.

5) Once the new membership agreement has been processed and fully executed, the GCO will move the New Membership forward to Account Set-up the original FP will be moved forward in parallel.

c) **Account Set-up**
**Type I Activities in SharePoint**

1) The PNT/OIRC GCO uploads a copy of the fully executed agreement and any other relevant documentation to the SharePoint task folder.

2) The PNT/OIRC GCO conveys all relevant instructions and/or information using notes to the AMT GCO via the “Negotiation Summary” field.

3) The PNT/OIRC GCO transitions the task from PreAward to PostAward by changing the task status to “Distributed” and selecting “True” next to “Distribute to Activations.”

**Type II Activities in SharePoint**

An account will not be set up when the consortium is initially routed and approved. Instead, the first signed membership agreement from an industry member will serve as the award letter for Type II consortium set up. See [New Memberships](#).

**Type I and II Activities in ERA**

The PreAward GCO runs the activity and uploads a copy of the fully executed agreement. This action transitions the FP from PreAward to PostAward within ERA.

### 2) New Memberships

**a) Proposal Review and Submission**

1) The RA creates an FP within ERA for each new membership.

2) The RA adds the company name and the time span for the draft agreement. ORSPA will add the signatories to the signature page. **NOTE:** If the membership agreement is already partially executed, the RA should make no entries. This will be done by ORSPA.

3) The RA proposal package must contain the agreement (whether a draft or partially executed) and budget details (how much money is expected to be received). The SmartForms (SF) will be completed except as noted in the [ERA SmartForm Instructions](#) contained within this job aid.
4) After the RA completes the SmartForms, the RA will enter a "Public Comment" stating that the request is for a consortium membership. The RA will also identify the consortium industry holding account and request the preferred acronym to identify the new member’s impending sub org. The PNT GCO or PNT student monitoring the ERA "No GCO Reviewer" tab will assign the task to the appropriate GCO. Following the GCO assignment, the task will appear in the assigned GCO’s ERA “My Home” page in the “Proposals in Process” tab.

5) Once a GCO has been assigned to the FP, the RA runs the ERA activity "Notify PNT", to review the draft of the membership agreement (if the agreement needs revisions). Oftentimes, the Consortium Chair has pre-negotiated terms with the sponsor. If this is the case, the RA can run the ERA activity "Forward for PNT Review" and include a note about changes needed to the agreement or the RA can run the activity "Notify PNT" and request the changes.

6) The GCO will draft the addendum (changes cannot be made directly within the membership agreements) and send it back to the RA via email or email RA with instructions to send out to the sponsor directly.

7) Once the RA has completed the relevant questions in the SmartForms; obtained all necessary approvals; and received back either a partially executed membership agreement or sponsor-requested changes to the draft, the RA will run activity "Forward for PNT Review". This activity will prompt the GCO to review the final proposal documents by moving the proposal into the "My Inbox" status.

8) The GCO reviews the FP to confirm all required fields are completed, using the PreAward Points of Reference as applicable, and checks that all approvals are completed.

9) If the GCO finds an error to be corrected, the GCO will request the changes by running the activity "PNT Requests Proposal Changes". The RA will then respond to the GCO regarding the changes by running the activity "Respond to PNT Request".
10) Once the GCO has confirmed that all required elements are in place, the GCO runs the activity (the GCO cannot move forward until this activity is run). The GCO then runs the activity to let the RA know that the proposal has been reviewed and approved.

b) Agreement Review and Execution

1) After the RA receives the activity from the GCO, indicating approval, the RA uploads the partially executed membership agreement or revised draft as the award document and the GCO runs the activity

If the RA has already uploaded the partially executed or draft as an attachment in the ERA site at the proposal stage, the GCO can request a task be set-up and assigned to him/her, by running the activity and leaving a “Public Comment” describing the situation. The student or GCO monitoring ERA will then assign the GCO agreement reviewer and set up a task in SharePoint.

2) The GCO reviews the partially executed agreement or draft against the consortium’s standard membership agreement. If changes to the agreement have been requested, the GCO evaluates the changes and determines if they are:

   a. Immaterial (e.g., an update to contact information). If a requested change is immaterial, the GCO will accept the requested changes.

   b. Material (i.e. substantially changes the meaning or intention of the clause). If a requested change is found to be material, the GCO will contact the AD for direction. Material changes cannot be made to a membership agreement. They must be made by way of an addendum.
3) It is not uncommon for a sponsor to have pre-negotiated the payment structure, auto-renewal and/or term specifications with the consortium contact prior to signing. If a change is for one of these sections, the GCO will confirm that the requests are consistent with the terms of the membership agreement and bylaws. If they are consistent, the membership agreement will be processed and signed as-is, but a modification, outlining the deviations, will be processed and signed simultaneously. The GCO must have documented proof of consortium chair approval of the changes, saved in the folder.

4) The SharePoint task notes and folder will be updated per the instructions found in the PreAward Negotiation Job Aid. Once all terms and conditions have been agreed upon, the GCO obtains AD signature to fully execute the agreement.

**NOTE:** This process is ONLY for original membership agreements. Future changes will be handled via the Renewals and Modifications processes.

c) Account Set-up

**Activities in SharePoint**

1) The PreAward GCO uploads a copy of the fully executed agreement and any other relevant documentation to the SharePoint task folder.

2) The GCO conveys all relevant instructions and/or information using notes to the AMT GCO via the “Negotiation Summary” field.

3) The PreAward GCO transitions the task from PreAward to PostAward by changing the task status to “Distributed” and selecting “True” next to “Distribute to Activations.”

**Activities in ERA**

The PreAward GCO runs the activity [Agreement Finalized] and uploads a copy of the fully executed agreement. This action will transition the task from PreAward to PostAward within ERA.

3) Membership Renewals

a) Definition

A renewal to a consortium membership is defined as the act of an existing member adding additional money and/or time to its membership. There are no requested changes to the terms and conditions or bylaws.
Consortium members often have the option of using different forms of payment to cover their membership fees. Two of the most common methods are:

1. Traditional - check or wire transfer of requested funds to ASU
2. In-kind - an exchange of goods or services, with a value equal to the requested dollar amount, in place of monies.
   - The donation of in-kind gifts of equipment (defined as $5,000 or more per individual unit) requires an appraisal or an estimate of the fair market value. Contact Property-Q@asu.edu to begin the process. For additional information, see PCS 206.

**NOTE:** If a member is changing the structure of payment, the renewal must be processed as a **Modification**.

b) **Process**

1) The RA or PI communicates to the member that the next year’s funding is due.

2) If the member agrees to renew, the RA sends the member an invoice for the amount due.

3) RA creates an ORSPA Action Form (OAF) and submits it to notifications@asu.edu per WI-EP-130 ("Noncompeting Renewal/Supplement").

4) The RA includes a statement identifying the consortium industry holding account and sub org the request applies to. The original FP number should also be included.

5) AMT submits the renewal documents to the member (if applicable).

4) **Consortium-Funded Projects**

   a) **Proposal Review and Submission**

1) The RA will create an FP within ERA for the new consortium-funded project. The proposal package must contain a statement of work (SOW), budget (BU), budget justification (BJ), and a copy of the award letter/e-mail. The SmartForms will be completed using the ERA SmartForm instructions contained within this job aid.

2) If a new scope of work has been approved for an existing project or a modification is necessary, a new FP must be created using the instructions for processing Modifications.
3) If an additional year/amount of funding has been approved for an existing project and no changes are being made to the terms and conditions, the RA does not need to create a new FP. Instead, the RA completes an OAF and submits it to notifications@asu.edu, in accord with WI-EP-130 ("Noncompeting Renewal/Supplement").

**NOTE:** If the FP is for a Non-core Project, skip to step 5.

4) The GCO will then run the activity, upload the award letter/e-mail, include notes to AMT (as requested by the RA), and selects “AMT” under “Choose the Appropriate Routing Option.”

   a. The GCO will follow up this activity, by sending an e-mail to notifications@asu.edu and including all of the required elements listed in Step 1. The subject of the e-mail will be “[Consortium Name] Project: [Technical Title].”

   b. The assigned AMT GCO will obtain signature from the AMT AD. No further action will be required of the RA or PreAward GCO.

5) If the proposal is for a non-core Project, and proposal submission or negotiation of the award is required, the RA will notify the GCO immediately by running the activity.

   b) **Agreement Review and Execution**

   1) The GCO will then immediately run the activity, upload the award letter/e-mail, and select “PNT” under “Choose the Appropriate Routing Option.”

   2) After the RA receives the ERA activity from the GCO, indicating approval has taken place, the RA uploads the draft as the award document and runs the ERA activity.

   3) The student or GCO monitoring ERA “No GCO Agreement Reviewer” tab will then set up a task in SharePoint for the agreement to be negotiated. An appropriate GCO Agreement Reviewer will be assigned (the GCO will change the GCO Agreement Reviewer to his or her name in ERA once assigned the task in SharePoint).
4) The SharePoint task notes and folder will be updated per the instructions found in the **PreAward Negotiation Job Aid**. Once all terms and conditions have been agreed upon, the GCO obtains AD signature to fully execute the agreement.

---

c) **Account Set-up**

**Core and Over-Fund Projects**

No further action is required.

**Non-core Projects**

Activities in **SharePoint**

1) The PreAward GCO uploads a copy of the fully executed agreement and any other relevant documentation to the SharePoint task folder.

2) The GCO conveys all relevant instructions and/or information using notes to the AMT GCO via the “Negotiation Summary” field.

3) The PreAward GCO transitions the task from PreAward to PostAward by changing the task status to “Distributed” and selecting “True” next to “Distribute to Activations.”

Activities in **ERA**

The PreAward GCO runs the activity and uploads a copy of the fully executed modification. This action will finalize the transition of the task from PreAward to PostAward within ERA.
5) Modifications/Addenda

a) Definitions

A modification (also known as an addendum) to a consortium agreement (whether membership or project-related) may be defined as the act of an existing member requesting material changes, meaning terms and conditions and/or bylaws. This may also refer to a change in the payment structure of an agreement (i.e. from standard to in-kind or vice versa). Any requested changes must be negotiated and approved by OIRC and/or PNT. Only OIRC and/or PNT are authorized to make changes to the standard membership agreements and bylaws.

**NOTE:** The RA will complete the SmartForms in ERA using the methods used in the original FP (i.e. if the modification is for core project, look to the core project submission instructions for guidance).
b) Proposal Review and Submission

1) The RA creates an FP within ERA for the modification. The proposal package must contain the agreement (whether a draft or partially executed) and applicable budget details. The SmartForms will be completed using Create and Route Funding Proposal WI, except as noted in the ERA SmartForm Instructions contained within this job aid.

2) The GCO will follow the instructions above.

c) Agreement Review and Execution

1) The GCO reviews the partially executed agreement or draft against the consortium’s standard membership agreement. As the change must be material in order for a modification to be processed, the GCO will contact the AD for direction.

2) If a requested change is in regards to payment structure, the GCO will confirm that the requests are consistent with the terms of the membership agreement and bylaws.

3) If in-kind payment is mentioned in the bylaws and is acceptable upon approval by the appropriate consortium authority, the GCO must have documented proof of consortium chair approval prior to move forward.

4) If in-kind payment is not mentioned in the bylaws or terms of the membership agreement, in-kind payment may still be allowable. Consult the AD for guidance prior to moving forward. Documented proof of consortium chair approval will be necessary in this scenario, as well.

   **NOTE:** The terms of an in-kind payment must be detailed in the modification.

6) Financial Management

   a. At-Risk Accounts

   Consortium-funded projects are not eligible for at-risk status.

   b. Project Funding

   1) There are two ways to fund a project with Consortium funds

   a. Issue a subcontract to an outside entity

   b. Fund a project internal to ASU

   2) If funding a project via a subcontract to an outside entity, follow the steps outlined in “Manage Subawards”. These types of projects will
not be set up as standalone accounts, but will be set up as child accounts to the main manager parent account.

3) If funding a project internal to ASU, each project is required to be set up as a standalone account. The project will follow the same process outlined in Create and Route Funding Proposal WI. The award notice must be uploaded to ERA in order to be forwarded to notifications@asu.edu for account set-up.

c. Allowable Costs

1) Consortium accounts are sponsored accounts so all expenses must allowable, allocable and reasonable to the project.

2) Allowability of administrative costs and how these costs are funded should be outlined in the bylaws of the Consortium.

d. Invoicing

1) The invoice template, which the RA may develop, must be approved by the consortium PI.

2) All invoices should, in addition to the invoice number, contain the consortium account number and the year of the industry membership being billed ... e.g. Invoice #: XYZ1001-2015.

3) The RA emails the invoices to members with a copy to cashmanagement@asu.edu.

4) Cash Management (CMT) logs the invoices for future reference.

e. Collections

1) The collection procedures, which may be developed by the RA, must be pre-approved by the consortium PI.

2) Timely collections of funds, as with proper invoicing are among the most important tasks of the RA.

f. Cash Management

1) CMT sends a pdf copy of incoming checks to the RA, along with the accounts the checks are being posted to.

2) The RA emails a thank you note to the industry member letting them know the funds have arrived. The thank you email template, which may be developed by the RA, should be pre-approved by the PI.

3) After 24 – 48 hours, the Consortium RA confirms in Advantage that the funds have been posted in the proper account.

4) Once confirmed that the funds have been posted properly, the Consortium RA sends a request to notifications@asu.edu regarding how to load the budget and cc’s their AMT GCO. For example, a portion of the funds might be posted to a main account, project account, or admin account, etc.
5) When the AMT GCO receives this email, it is their queue to coordinate the revenue request.

6) When the funds are deposited into the Manager account, CMT sends an email to notifications@asu.edu, which will trigger an activation task.

7) The AMT GCO will load the funds into 8201 and the Admin portion is loaded into the Admin account, either in 7390 and 8201 or according to budget provided by the RA (the GCO will general reach out to the RA to get the budget).

8) The funds are held in the Manager account until a new Consortium funded project proposal has been award or an OAF has been submitted to move funds to an existing project account.

9) The revenue received will follow the budget dollars, which means the AMT GCO will request the revenue transfers to move funds to and from the Manager account.

G. Account Monitoring and Reconciliation

Consortium accounts are managed by the same work instructions as standard sponsored accounts that are outlined in the Execute Project work instructions. The AMT GCO will review on a quarterly basis.

h. Unused Funds

Funds leftover from a consortium-funded project account can be returned to the Manager account if a project completes before its termination date and deliverables have been met. This request would be submitted on an OAF to notifications@asu.edu.

i. Account Closeout

Consortium accounts are managed by the same work instructions as standard sponsored accounts that are outlined in the Close out work instructions.

Upon close out of a project account, all residual funds will be moved to the Manager account.
ERA SmartForm Instructions

1. The RA creates an FP within ERA.

2. The SmartForms (SF) should be completed using Create and Route Funding Proposal WI, except as otherwise noted below.

**SF 1.1, Question 1.0, Full Title of Proposal**

[Consortium Acronym] Member: [Industry Member Name]

**SF 1.1, Question 2.0, Short Title of Proposal**

- New → [Consortium Acronym] Member: [Industry Member Name]

**SF 1.1, Question 3.0, Sponsor Principal Investigator/Fellow**

- New Membership → Consortium Chair/Director
- New Consortium-Funded Project → Faculty Responsible for Project, not consortium PI unless he/she is the Project PI.
- Modifications → Consortium Chair or Project PI, as appropriate

**SF 1.1, Question 6.0, Select Sponsor**

- New Membership → Industry Name
- Core Project → Consortium Name
- Non-Core → Industry or External Sponsor Name
- Modifications → Industry, Consortium or External Sponsor Name

**SF 1.2.1, Question 1.0, Select the Lead Financial Unit**

- New Membership → Leave the auto-populated information for the PI’s regular Lead Financial Unit
- Changes to Consortium → Override auto populated info → Insert Consortium Code
• Changes to Consortium-funded project → Leave the auto-populated information for the PI’s regular Lead Financial Unit

SF 1.1, Question 8.0, has this proposal already been submitted to the sponsor?

SF 1.2, Question 4.0, Indicate whether this is a Grants.gov funding announcement and if so, whether you want to submit via system to system or not. → OTHER

SF 1.2, Question 5.0, who will submit the proposal? → ORSPA

SF 1.2, Question 6.0, Instrument Type → Contract

SF 1.2.1, Question 1.0, Select the Lead Financial Unit

Insert Consortium Code (will need to override the auto-populated information)

SF 1.2.1, Question 3.0, Investigator Allocations –

Leave the first box as the auto-generated allocation (PI’s regular Lead Financial Unit information) and manually input the correct Consortium Code in the ABOR column (this information should match the answer in 1.2.1 Question 1.0)

SF 2.1, Special Reviews

• New Membership → “No” to all Questions
• Consortium Funded → According to project

SF 4.2, Question 2.0, Delivery Instructions – “Internal”

SF 4.2, Question 3.0, Application Submission Deadline Date and Time – Select a Date when the RA expects all Department Approvals to be Complete

SF 9.2, Question 1.0 – Click on “Links to Budget Form”
BM Question 7.0, Direct Cost Target – Leave at $0

BM Question 4.0, Enter Consortium F&A Rate and “TDC”

BM Question 8.0, Match Answer from 1.2 Question 4.0

BM Question 9.0, “Consortium established F&A rate.

BM Sponsor Budget, Used for the amount being contributed in cash ONLY.

BM Cost Sharing Budget, Used for third party cost sharing ONLY.

If the sponsor will be contributing cash and in-kind or only in-kind.

BU 2.0.1, Question 2, Will this budget have cost sharing? → “Yes”

SF 9.2, Question 1.0 – Click on “Links to Budget Form” for Cost Sharing for Sponsor Name.

CS 3.7, Question 1.0 – Select “”

CS 3.7 Question 2.0 – The total cost sharing budget should be $0.

CS 3.7 Question 4.0, Enter third party Cost Sharing Information – Select the Add button and a popup will appear.

Popup, Question 1.0 find the third party funding this research.  
Popup, Question 2.0 enter the description and the cost.  
Popup, Question 3.0 leave this field blank.
CS 3.7 Question 10.0, Total cost sharing commitment to Sponsor – Should equal Question 4.0.